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Investigations into the Third Dimension: 3D 
Scanning in UNT Libraries Digital Collections 
 

Abstract 
This research project explored the inclusion of 3D scanned items in UNT Libraries’ digital 

collections. The researcher used a NextEngine HD 3D Scanner on selected materials from UNT 

Libraries’ Special Collections Department to learn and adapt the 3D scanning and printing 

process to local resources. The outcomes from the project include an overview of current 

methods, equipment, uses, and file formats for 3D scanning; a case study discussing UNT 

Libraries’ digital library infrastructures capacity to host, render, and preserve 3D scanned data 

and models; and a recommendation in regard to the pursuance of 3D scanning in UNT’s digital 

collections area. 

 

Introduction 
There are a number of ways to examine an object. If the object is nearby, through the senses-- 

touch, taste, smell, sound, and sight. New technologies have extended the reach and sensory 

experiences of objects that are not physically available. They also assist in accessing items 

whose nature makes it prohibitive to handle—or those objects that it is simply impossible to 

sense unassisted. For example, digitization has revolutionized the access of documents and 

photographs from afar and provides representation of three-dimensional objects if only 

through flat, two-dimensional perspectives. Newly engineered three-dimensional scanning (3D 

scanning) similarly are used to assist in the visual experience of these objects in ways that were 

previously unavailable.  

3D scanning is the process of capturing and remodeling physical objects into three-dimensional 

digital models. The process is the reverse of the more familiar concept of 3D printing: “three 

dimensional printing takes virtual data and makes it into reality… whereas 3-D [sic] scanning 

takes a physical object and creates a digital object (and also the raw data) from it” (Reuscher, 

2014, p. 65). 3D scanning has many applications in a wide variety of fields. 3D developers us 3D 

models for animating or visualizing an object, making changes to an original object to create a 

new one, reconstructing damage that has been done to an object, and comparing and analyzing 

an object. They are also used “for archival purposes to accurately record the state or form of an 

object.” (Direct Dimensions, 2016, Ch. 1) A number of fields including entertainment, 

engineering, medicine, dentistry, art, and archeology have already begun to apply 3D scanning 

technologies to their work. Some companies use 3D scanning to verify the dimensions of 

objects that are reverse engineered, or CAD modeled, for their clients. For special collections, 

or archival objects, 3D scanning can provide access and a new perspective to those three-
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dimensional objects that have heretofore only been captured in two dimensions. A number of 

cultural heritage organizations have begun exploring using 3D scanning technology to preserve 

and provide access to their collections and artifacts (Smithsonian X 3-D, 2017; Means, 2013), 

the collections of their faculty (Wackerman, 2009), or offering 3D scanning as a service to 

constituents (Reuscher, 2014).  

In spring of 2015, The University of North Texas Libraries Dean awarded a researcher in the 

Digital Libraries Division an internal grant called Green Light to Greatness Grant. The grant 

proposed to 1) explore how 3D scanning is currently implemented, organized, and archived by 

government, academic, and private institutions; 2) determine if UNT Libraries’ digital library 

infrastructure has the capacity to host, render, and preserve 3D scanning files; and 3) provide a 

recommendation for or against further pursuance of 3D scanning. This paper documents the 

project’s process and recommendations and serves as an example of the creation and 

preservation of 3D models in a non-proprietary digital repository system.  

 

3D Scanning Overview  
Like traditional 2D digitization, 3D scanning creates a digital representation of a physical object. 

In the same way that 2D digital images use dots per inch, dpi, to create an image, 3D models 

use thousands to billions of points situated on three coordinates, X, Y, and Z, to recreate the 

physical object in a digital space (Johnson, 2016, p. 42). Generally, “3D scanners collect 

information about an object’s position in space” and, depending on what kind of scanner you 

have, information about its color and appearance (Smith, 2015). There are several methods, 

and tools, for collecting these data points in 3D scanning. 3D operators select a scanner based 

on the object being scanning and the kind of scanning the operator would like to do.  A sample 

of data collection methods include laser scanning, digitizing or contact scanning, image-based 

capture or photogrammetry, white light scanning and computed tomography or CT scanning 

(Direct Dimensions, 2017, Ch. 2). CT scanning captures the internal structure of an object. 

White light scanning is similar to laser scanning. It can be considered more accurate to a certain 

degree, but slower as it only captures via grid of light one shot of the object at a time (White 

Light Scanning, 2016). Photogrammetry, compiled 2D photographic images, is another way of 

capturing extremely detailed, graphical three-dimensional views of an object from each angle. 

Photogrammetry does not provide a record of the object’s surface geometry or physical 

structure (Wachowaik, 2009, p. 142).  Contact scanners, or digitizers, make use of a probe to 

gather data-point information. They are best used to capture the shape of geometric objects 

that can be handled (Direct Dimensions, 2017, Ch. 2). Contact scanners do not work well with 

objects that are delicate or too big. For these, it is better to use a non-contact scanner that uses 

lasers instead of probes. Like a contact scanner, a laser scanner gathers surface data about 

objects in a particular field of view.  
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The researcher selected the NextEngine Laser HD 3D Scanner for the pilot project. It was 

selected based on in its accuracy in comparison to other scanners (e.g. Makerbot), its resolution 

capacity (.01 mm resolution and .01mm error), and price (within the $5000 max grant limit at 

$2,999). The NextEngine was the scanner of choice of among other similar institutions and 

offered support and documentation for inexperienced scanners (NextEngine Gallery). The 

NextEngine uses four lasers and two cameras to collect data of the object in a process called 

optical triangulation. The scanner projects four beams of light onto the object’s surface and 

sensed by the two cameras. The cameras photograph the object at each angle. The NextEngine 

ScanStudio software takes this information and calculates the spatial coordinates of individual 

points. The software then processes the information and generates a 3D model. The inside 

ScanStudio the model renders in four varieties: full color, shaded, mesh, and points. The full 

color view shows the object with its color rendering; the shaded view exhibits the shaded 

geometry of the object and provides a better view of surface topography without color; the 

mesh view shows how the object is formed through polygons, and the points few exhibits the 

data on a dot level.  
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Figure 1 (top right to left) Color, Shaded, Mesh, and Point views in NextEngine ScanStudio Software  

 

The scanner comes with a large rectangle the size of a medium cereal box, a detachable power 

cord, a turn-table with attached cord, a turn-table cord extension, a turn-table stand, and a box 

of supplies to prep objects and ease the scanning process. The supplies include a rectangular 

block of orange putty for positioning objects on the turn-table at various angles, paint pens for 

marking alignment spots on an object, and a powder pen to reduce reflectivity. 
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Figure 2 NextEngine HD 3D Scanner out of the box and ready to scan 

 

3D and UNT 

Selecting Objects 
The next step after acquiring the NextEngine 3D Scanner was to select items to scan. When the 

project was initially proposed, the researcher requested the assistance of Special Collections 

Librarians and identified unique Texas-produced glass bottles and toys from the Alexander M. 

Troup Collection and several items from the Miniature Books Collection. The researcher soon 

discovered after preliminary testing with the scanner could not scan the translucent materials 

without the addition of powder or scanning spray, as is traditional for 3D scanning materials in 

other fields. Since the researcher would be working with Special Collection items, they decided 

that the glass bottles would not be the chosen specimens. Instead, the researched selected 

objects from the miniature books collection for scanning.  

The books selected appeared to have unique textural qualities. Of these items, the researcher 

was able to learn which scanned well and which did not. Many 3D scanning practitioners 

suggest, “Non-metallic, opaque objects with minimal convoluted surfaces, e.g., objects that do 

not have overhangs or undercuts where the laser beam cannot reach“(Surendran, 2009, p. 

250).  The research and special collections librarian preferred older books with clasps and tight 

bindings or solid objects. Non-shiny, or dull metal materials were also preferred. The books that 

were hardest or did not scan successful were made of materials that other 3D scanning 

practitioners describe as being difficult. Translucent materials, such as colored glass or see-

through plastic posed issues; small objects additionally were difficult to capture and process. In 

general, the researcher would suggest solid, stationary, opaque, or matte objects with 

interesting tactile natures as the best options for easy scanning.  

Towards the end of the project, one of the above-mentioned special collections librarians 

identified the possibility of scanning moveable-type casting hand moulds. A hand mould is a 
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15th century invention made of two metal and wood pieces. It holds an impression piece of a 

piece of type, called a matrix, and contains the very hot, liquid metal that is poured into the 

mould to cast the piece of type. The process is difficult to explain without hand mould pieces 

and accessories to use as examples. The hand moulds and accessories, however, are hard to 

acquire. Thus the idea 3D scanning a hand mould, punch, matrix, type, piece jet, and 

compositing stick was birthed. The special collections librarian located hand moulds and other 

materials to scan at with the help of a librarian colleague at Texas A&M University Libraries. The 

researcher, seeing the opportunity for direct application and the variety of material sizes and 

shapes from that of the miniature books, incorporated the objects into the 3D scanning tests. 
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Scanning Set-up  

 

Figure 3 Scan Settings window in NextEngine ScanStudio software 

To begin the scanning process, the operator positions the object on the turn-table and turns on 

the ScanStudio software that runs the NextEngine scanner. On the software’s settings page, the 

scanner operator makes sure the whole item is in view during the 360 turn. He or she also 

selects how many Divisions to scan. This project most often used 8 divisions, or 45 degrees, for 

each scan. The operator next selects the Target exposure setting to adjust the amount of laser 

light actually directed at the object. The three options are dark, neutral, and light. A darker 

colored object would require the dark setting, and a lighter object, such as one with a lot of 

reflectivity that is powdered white, would require the neutral or light setting. The operator 

selects the desired Resolution (Points/IN3), with nine options ranging from quick to high 

definition (HD). He or she also picks one of two available basic Range settings from the scanner: 

The Macro setting of 7-11 inches or the Wide setting or 22-27 inches.  
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Figure 4 Scanning Trials Setting Data 

 

Before each scan, the researcher recorded in a spreadsheet all of these settings in addition to 

the date the object was scanned and the name of the object. In the beginning, it was thought 

that actual time could be compared to time estimated time by the program, but this goal 

become unrealistic because the operator would need to watch the automated scanning process 

the whole time in order to get the exact stopping point. Each scan varies, but were on average 

40 minutes long.  Additionally, the effect of ambient lighting or a dark setting on the scanner 

was unknown at the beginning. It was soon discovered that no real difference appeared 

between the two. Ambient light was used for the rest of the project. 

 

Figure 5 Scanning orientations in NextEngine ScanStudio 

 

Once all the settings had been determined and recorded, the object was scanned for about 40 

minutes for eight divisions. Brackets, or a three-division capture of one angle of the object, took 

15 minutes to scan. After the initial 360-degree scan, the research took one or more additional 

scans of the object to capture data not visible to the scanner system during the first rotation. 
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Figure 6 (Top Left) Raw Scan, Trimming Scan, (Bottom Left) Aligning the scans, Fusing the scans  

 

Following scanning, the model enters the processing phase. This part can be more complex 

than the initial data capture. In capture, the turn-table and stand are also modeled in the data. 

These pieces must be trimmed out of the model. The two or more datasets from each scan then 

must be aligned to create a single model and then fused to solidify the individual mesh. All this 

can be done in the ScanStudio software. The processing steps that followed this, however, were 

conducted more easily in other applications; so the model was outputed initially in OBJ file 

format, but later also in STL format as well. OBJ is an open file format that offers a textured, or 

colored, view of the 3D model. The STL, or STereoLithography, format is also open and most 

frequently used for 3D printing.  

The further processing of the model is dependent on the state of the scan data and the 

resulting model. Some objects are shaped and better suited for easy scanning, and require less 

processing. The aim for all models is to create a water-tight, or hole-less, representation of the 

object. This goal is more specific to printing a model than just having a digital representation. It 

was decided, based on the technological resources available that this, printing not necessarily 

digital viewing, would be the aim of the objects scanned in this initial project.  
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There are number of ways and programs used to create a nice, water-tight mesh of the scanned 

data. The researcher selected the open source programs Meshlab and Meshmixer for this 

project. They both and have tutorials and documentation enhance a model’s appearance. There 

were three main issues the researcher encountered with the models of the miniature book 

collection that needed fixing: 1) size, 2) holes, and 3) overall appearance.  

All three of these can be fixed in both Meshlab and Meshmixer. The first, size, involved 

reducing the number of triangles and faces of which a model is composed. The process of 

reducing this number is called decimation. Both programs had options to decimate the models 

by percentage – e.g. reduce the number of triangles and faces in the model by 50 percent—or 

by, more or less, the exact number of triangles and faces desired. 

 

Figure 7 Decimation window in Meshlab software 

The resulting model would have fewer triangles and faces, and thus be easier to manipulate in 

the software, and reduce the physical size of the model. 

The second biggest issue with some models with uneven pages was the size and number of 

holes. Meshlab and Meshmixer both have automated filters or algorithms to detect and close 

holes. One or the other programs worked better on the model depending on the model’s holes. 

Some holes, however, were uncloseable without resulting in visible harm to the appearance of 
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the model. In which case it is a matter of collecting more data by scanning at different angles. 

Admittedly, there were items that were unfit for scanning such as those that moved between 

rotations or were made with reflective material. 

Meshlab’s Poisson filter could improve the physical appearance of the model. This algorithm 

reduces the scanning static and fills the holes in a model’s mesh. It did not always fix the model, 

but very often did a very good job at smoothing and filling surfaces. The downside of the 

Poisson filter is that is must be applied to the whole model rather than selected portions. In 

Meshmixer there is an analysis tool that works to fill holes as well. Some nearly watertight 

models responded well to this feature in the software. Finally, the researcher sent the files 

through the Microsoft/Netfab 3D print repair tool to make sure the models could be 3D printed 

without causing any errors during the printing process. The tool additionally reduced the size of 

the model. (This tool is still available, but no longer exports the finished files in .STL file format.) 

 

Packaging  
The next step in the lab workflow to prepare the files for upload was to capture 2D images of 

the model utilizing the CAPTURE feature in Meshlab. The researcher rotated and captured no 

more than ten images in order to create a GIF in Photoshop of the model. This GIF would serve 

as the “in-the-round” option for within-browser viewing.  

 

Metadata 
With the 2D images, GIF, STL (both the original data and the processed printable version) and 

OBJ files ready, the next step embarked upon was metadata. From the physical object’s UNT 

Libraries catalog record, the researcher selected information that best suited the 3D model. The 

link to the physical object’s catalog record was included in the 3D model’s metadata record in 

the Identifier section as UNT-CAT.  

The project used the established metadata standards for UNT Libraries (UNTL) digital 

collections. Of the twenty-one possible field options, the fifteen used were title, creator, 

contributor, publisher, date, language, description, subject, coverage, collection, institution, 

resource type, format, identifier, and note. The main difference in describing a 3D model 

emerged in how the UNT Digital Collections understands the digital files in relationship to the 

physical objects they represent. These differences manifested in the fields date, description, 

and resource type.  

The date field traditionally had been used to describe the creation date of the object being 

represented. The researcher decided in conjunction with the UNTL metadata and Digital 

Projects Department Head that this date would be misleading, and confusing, to potential 

model users. The date field was instead filled with the date the model was created. References 

to the physical object’s date of creation were included, but in the coverage field. 
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In 2D digitization and metadata creation at UNTL, the scanned images represent the physical 

object. So rather than describe a scan of a letter in the content description field as “A scan of a 

letter by Stephen F. Austin,” the field usually state “A letter written by Stephen F. Austin.” The 

researcher, again with guidance, found this typical type of association inappropriate when 

describing a 3D model. The model is representative of the physical object in the digital realm 

rather than its internal contents, e.g. its pages. The content description it was decided would 

read “3D scanned model of…” the object. The physical description was also tweaked to be more 

in alignment with 3D scanning and printing standards. The UNTL digital collection standards 

dictate that the physical description of an item should be described in centimeters, while most 

3D work is described in millimeters. It was decided to use millimeters in the field as it would 

best communicate the dimension of the model to those familiar with 3D objects. 

The decision on how to describe the kind of resource manifested by the model, gave the 

researcher pause. There were many. Those notable included, physical object, book, image, and 

dataset. It was decided that dataset would be the choice for 3D scan model data because the 

repository would preserve and allow access to the edited printable model, but also to its raw 

scan data so users could do their own processing. 

Last, as a way of maintaining best practices when archiving data, the researcher, with guidance, 

included a README.txt file for the user that explained the project, described the models 

included, and gave some information on how the printed files were processed and in what 

software. It additionally reported the size of each of the files, and the object rights information 

-- creative commons public domain license (CC0). 

 

 

 

 

 

 

 

 

 

 



14 
 

Presentation 
The research next divided the files into PNGS (Figure 8), GIF (Figure 9) and models (Figure 10) 
and uploaded them with the metadata into the UNT Digital Library’s Rare Book and Texana 
Collections and the Miniature Book Collection (http://bit.ly/2gZuMuG). 
 

 

Figure 8 A Muhi Csata 3D Model in the UNT Digital Library 

http://bit.ly/2gZuMuG
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Figure 9 The PNGs of A Muhi Csata in the UNT Digital Library 
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Figure 10 The GIF of A Muhi Csata in the UNT Digital Library 

 

 

Figure 11 All Formats view for downloading the data, models, and viewing the GIF 
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Printing 
The one step in the workflow that most often followed the completion of the model and before 

the 2D images were captured was to send the model off to be 3D printed in UNT Libraries’ 

makerspace, The Factory, or another 3D printing source-- such as the 3D Hubs website or a 

local 3D printing vendor. This step was valuable to the researcher for verifying the printability 

of the scans. The student workers in The Factory, 3D Hubs Hub owners, and local vendor 

MakerTree offered useful feedback on the water-tight requirement of the scans, their 

orientation, and indicated any flaws in the meshes that would hinder or cause difficulties during 

printing. 

 

 

 

Figure 12 Examples of the 3D scanned and printed miniature books 
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Data and Results 
 

Number of Objects Scanned: 64 

Number of Objects Uploaded: 15  

Number of Items Printed: 23 

Number of Total Individual Scans Taken: 235+ 

 

 

Of the 64 Miniature book and book history items selected and attempted for scanning, 15 of 

the miniature books have been uploaded, so far, into the UNT Digital Library.  Many of them 

manifested un-repairable holes. (It was discovered at the end of the project that these may be 

fixed with more scan data at different angles using molding clay to prop them.) Several items 

had loose binding or could not be rotated without part of it moving between the two or more 

scans and thus created models with poor alignment. Several other of the models could not be 

completed because they were shiny or metallic material or translucent in form. The traditional 

remedies for this issue-- scanning spay, talc powder, etc. – were not applied because of the 

special collections nature of the objects.  

Discussion 
The project enabled the researcher to encounter and overcome many challenges while 

discovering how to 3D scan. These challenges included examining the project scope, best 

workflows, software, hardware, and best practices for 3D printing. 

The first lesson—soon discovered—was the importance of the number of items attempted for 

the case study. The researcher aimed to scan 50 items, but upon gaining a thorough 

understanding of the process and the time allotted towards working on the project, the 

researcher advises attempting fewer objects for future investigations. It is recommended that 

one be choosy and aspire to less as 3D scanning is currently a craftsman’s process that requires 

a good deal of time for each and every model. There is a learning curve that can be climbed in 

trying to scan many objects of similar dimensions and formats; but it is advised that one start 

with a few objects of varying sizes, formats, and compositions to gain experience.  

Another challenge lay in learning that the ScanStudio software is not as robust in processing the 

scans as one may hope. The researcher initially had a good deal of trouble filling holes, cleaning, 

and improving the appearance of the scan in ScanStudio alone. It was in answer to this issue 

that the researcher sought out and learned the other programs, Meshlab and Meshmixer. 

However, other NextEngine users suggest purchasing the Rapidworks software from 

NextEngine in order to reduce the time and increase the quality of scans – particularly for the 

ability to process textured or colored models.  
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Solutions developed for workflow problems may be beneficial to someone just starting 3D 

scanning. The first is to take a picture of the scan item before 3D scanning. These pictures work 

better for quick identification of an object than opening its larger 3D model file. They also help 

with comparing the accuracy of the scanned object and its 3D model. Next, using a unique 

identifier that matches the object as it is cataloged elsewhere is also suggested. Additionally, 

creating a system early on for managing different file formats and versioning is encouraged. The 

researcher was able to create the system described in the appendix after the need was 

identified. Last, while in some forms of scanning, the digitizer can scan materials in bulk and 

process or edit after, it is suggested that processing occur directly after scanning. In this way, 

the scanner can determine at the middle or towards the end of the process if capturing more 

scan data will be needed to complete the item. 

 

Recommendations  
The last portion of this project was to recommend whether the UNT Libraries should continue 

to pursue 3D scanning now, in the future once better technology has developed, or not at all. 

There are certainly a number of challenges that come with delving into 3D scanning including 

resources, the learning curve, and lack of standards. Workflows developed can change in a day 

as new tools are discovered or disabled. Yet there are many promising opportunities in the 

present state of 3D scanning.  

The researcher submits the opinion that UNT Libraries should pursue research in 3D scanning, 
but with some suggestions. First, while it is our current digitization model to offer scanning 
services to partners, this practice is not suggested for 3D scanning at this time with the current 
resources. The items that are selected for 3D scanning should be thoughtfully curated due to 
the amount of time each item may take. It is also suggested that the more specialized software 
for the NextEngine be purchased in order to gain speed, editing features, and the chance to 
create textured models. Additionally, it is suggested that a gaming computer with graphic card 
and significant amount of RAM be purchased in order to minimize the time required to process 
the models. 
 
There are a number of questions, or research avenues, to pursue when examining 3D scanning:  

 User experience: Studying and then improving the user experience of finding, 

downloading, and using 3D data and models.  

 Viewers: The development of a quality non-proprietary 3D model viewer that can be 

integrated into digital library repositories is desired. Many 3D enthusiasts utilize services 

like Autodesk and Sketchfab.com to display their 3D models. While these are lovely and 

well-designed websites, the need for an open source option that can be used inside of a 

digital repository is an area of much demand.  

 Rights: Scholarship explaining and applying copyright to 3D scanning and printing is 

desired.  

http://www.autodesk.com/
https://sketchfab.com/
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 Standards: Developing best practices of scanning, processing, and offering models to 

users.  

 Assessment: The ability to evaluate models and quantify their use. 

  

Item Description Cost 

Rapidworks 
Software 

Software designed for NextEngine HD 3D 
Scanner to develop parametric CAD models. 

$1995 -- $2,995k 
depending on 
educational discount 

Gaming PC With robust graphics card, Core i7 
processor, 32+ GB RAM, 

$899- $2,000 

Gaming Monitor 22 – 27” wide $209 -$669.99 

EinScan Pro 3D 
Scanner 

Structured Light 3D scanner with fixed and 
hand hold modes. 

$3999+ 

Figure 13 Equipment wish-list for increased efficiency in 3D scanning at UNT 

 
 
Future steps for the researcher include continuing to collaborate with Special Collections and 
Texas A&M University librarians to create book history 3D models and prints. The researcher 
will additionally, and in order to explore some of the above avenues, be pursuing grant funds in 
order to purchase the above materials and possibly a second scanner with newer technology 
that would significantly reduce the time for scanning as well as boost quality and detail of the 
scans.  
 

Conclusion 
The research began with the aim to explore the developing and innovative world of 3D 

scanning, to learn the process of 3D scanning by generating models of special collections 

objects, and to offer a recommendation for or against the pursuance of 3D research. Because of 

this project, the UNT Libraries has gained a 3D scanner, a tutorial on how to operate it and 

process the resulting scans, novice knowledge on its operation, this report and the 

recommendation for further research, and a collaboration with Texas A&M University Libraries.  
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Appendix: Digital Projects Wiki Page for Next Engine 3D Scanning (As of 

Summer 2017) 
Scanning 

1. Find an item that is not metallic, shiny, or see through (nothing with colored plastic, or 
any other translucent features). 

2. Take pictures of the item and save them in the folder named after the object. 
o Example: an object to be name den_geest should have a files named “den-geest-

picture_01.png, etc.” placed in its folder that is also named “den_geest”. 
3. Adjust the settings on the NextEngine Settings window that appears after pressing the 

triangular scanning button. 
o Division indicates how the 360-degree rotation will be divided during scanning. 

The recommended number of divisions is eight (45-degrees). 
o Target is an exposure setting used to adjust the amount of laser light that the 

object will experience to return data back to the scanner. Adjust this setting 
depending on the reflectivity and color of the object.  

o Powdered white objects will want the Light setting. Dark colored objects will 
scan better on Dark, and object in between dark and light can be set to Neutral. 

4. Record the name of the object in lowercase using an underscore for spaces at the top of 
the Settings window. You will want to record the name and settings selected in a 3D 
scanning record spreadsheet.  

5. Make sure the item is viewable all the way around by pressing the turn option on the 
top right. The two inner buttons will make tiny adjustments. The outer buttons do a full 
division. 

6. Press Scan 
7. After the item has completed the 360-degree turn, rotate it 90-degrees to capture the 

missed data from the top and bottom.  
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Figure 1 Example of miniature book’s vertical and horizontal raw scans  

 

Preliminary Processing in ScanStudio 

8. Trim scans: Click Trim on the ScanStudio window menu at the top. Use the square and 
circular, and rectangular tools to select the parts of the turntable and delete them with 
the Trim button. The “+” means the selected area, shown in red, will be deleted. To 
finalize the trim press the Trim button on the right.  The “-“ appears blue and allows the 
operator to remove the red selections that have been made. 
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Figure 2 A view of the trimming process. The extraneous materials are selected in red. 

 

Figure 3 An image of the post-trimmed model.  

9. Align scans: After all the scans have been trimmed, click Align on the top menu. Select at 
least three points on each of the scans to match them using the colored dots. Each 
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matching dot should appear on the same spot on both scans. Press Align. If the 
alignment does not look right, you can do it over by pulling the finalized object, in green, 
into the blue area of the processing screen. This will divide the object back into its 
separate parts. 

 

Figure 4 A look at the aligning and refining process using the three points on each model. 

10. Refine: After alignment is finished, press Refine. 
11. Fuse:  After two or more scans have been aligned, click on the Fuse button on the Menu. 

Once inside click Fuse to connect the two meshes into one. 
12. Output: Output the model as an STL (binary) or .stl file and save it a folder you make 

called “stl” in the object’s main folder. Do the same for the OBJ file format and save it in 
a “obj” folder. Last explort a PLY format, which is found under “More”, and in the 
dropdown of the save window. Save the .ply file into a “ply” folder that you create. 

Polishing and Decimation in Meshlab and Meshmixer 
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13. Open the program Meshlab and Import the STL file into the software by clicking the 
open folder or File =>Import Mesh. Click OK to Unify Duplicated Vertices. 

14. Click the Show Layers Dialog button (Appears as several layers stacked on top of each 
other next to the camera button). So that a window appears to the right. 

 

 
Figure 6 Example of the Poisson filter view in Meshmixer before applying.  
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Figure 6 Example of the Poisson filter view in Meshmixer after application.  
 

15. Click Filters => Remeshing, Simplification and Reconstruction => Screened Poisson 
Surface Reconstruction (formerly “Surface Reconstruction: Poisson”) 

o Click the black down arrow to see all the fields 
o In the Poisson Filter window insert: 

 Merge all visible layers: Uncheck 
 Reconstruction Depth: 9 
 Adaptive Octree Depth: 11 
 Conjugate Gradients Depth: 0 
 Scale Factor: 1.1 
 Minimum Number of Samples: 1.5 
 Interpolation Weight: 4 
 Gauss-Seidel Relaxations:8 
 Confidence flag: Unchecked 
 Pre-Clean: unchecked 

o Click Apply 
o This process will take a while. After a minute or several, a second layer will 

appear in the right window. The model will look the same until you turn the eye 
next to the first layer off to reveal a smoother, watertight model. 

o Delete the original layer – right click on it and select “Delete Current Mesh” 
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16. Decimate: Next, reduce the size of the model’s vertices, faces and size. Click Filters => 
Remeshing, Simplification and Reconstruction => Quadric Edge Collapse Decimation. 
Select either the exact number of faces desired or the percentage as a decimal.  

o Percentage is recommended in increments of .5 
o Add a Quality threshold of 1, click Preserve Boundary of the mesh and all the 

options at the bottom except “Simplify only selected faces” and “Weighted 
Simplification”. 

o Click apply 
o 3D Hubs suggest models not be larger 999,999 faces or 128MB. If the model is 

not small enough, simply click Apply again until you receive the desired result. 
17. Export the mesh by going to File => Export Mesh As and select STL. DO NOT save over 

the original STL file. Save the new file as [file_name]-pois. 
o Ex: den_geest.stl => den_geest-pois.stl 

18. Watertight: Next, verify the manifoldness of the model by importing it into the 
Meshmixer software and using the Inspector tool. Analysis => Inspector 

o To manipulate the model, one must press Alt while clicking.  
o Click run analysis 
o Any little blue, yellow, magenta, and red ball that appear indicate issues. 
o You can have them all corrected at once or click each individual ball to fix that 

issue. 
19. Export the model name it “model_name-print.stl”. 

 
 
 

Final Packaging 

20. Capture the 2D images: Re-open the model in Meshlab. Using the camera button on the 
top right menu take 8 or less snapshot of horizontal 360-degree rotation. And no more 
than 4 more vertically (for a max of 12). 

o Save the files in a folder you create called “png”.  
o The base name of the files should be in the format  [object-name-_count] . The 

counter should be adjusted start with 1.  
o Unclick “Transparent Background’ for each snapshot. 
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Figure 6 Generating the GIF in Adobe Photoshop. 

21. Make the GIF: Open the 8 horizontal rotation photos in Adobe Photoshop. 
o On the second image in the Layers window, right click on the layer and select 

“Duplicate  Layer”. 
o Name the layer the same as its original file. So model-name_02 would be Layer2 
o Click the dropdown next to Document: and pick model_name_01 
o Click OK 
o Duplicate layers for all the other 7 images.  
o Click on model_name_01. All the added layers should appear in the Layer 

window. 
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Figure 7 A view of all the other layers on Layer 1 while make the model GIF.  

o Click Window => Timeline => Create Frame 
o Create a new frame for each of the 8 layers 
o Click the eye of each layer so that only one is showing on each frame 
o Select all the frames and changes the speed to .5 seconds 
o Select Forever  
o Go into Image => Image Size and change the resolution to 72 
o Save the PSD file in the png folder. 
o Click File => Export => Save for Web (Legacy) 
o  Preview the GIF before pressing Save by using the control buttons on the 

bottom right. 
o Save the GIF in the “02_gif folder”.  (Format: Images Only, Settings: Default 

Settings). 
22. Find the record for the miniature book in the library catalog and create the metadata 

record. 
o Use the year the 3D model was created in the Date field 
o Add the date the physical object was created to the Coverage field, if known 
o In the content description field write “A 3D model of…” and use the description 

found in the catalog record. 
o Describe the Physical Description of the model in millimeters. Height, width and 

volume can be found in Meshmixer => Analysis => Dimensions. 
o Add any relevant notes that don’t fit elsewhere to a Display Note field 
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23. Create the README.txt file based on the example below 
24. Sort files as follows in a folder named after the object: 

o 01_pngs/ 
o 02_gif 
o 03_model 

1. filename-print.stl 
2. filename-raw.stl 
3. filenames-textured.zip 
4. README.txt file 

o metadata.xml 
25. Put the folder with the object’s name into the toUpload folder for the project. 

Example Readme.txt file text: 
 
Readme for 26 type designers 3D model Dataset: 
================================================= 
 
This dataset is being made available using a Creative Commons CC0 
Public Domain Dedication. See http://creativecommons.org/publicdomain/zero/1.0/ 
 
Dataset Overview: 
----------------- 
 
The files originated from a NextEngine 3D Laser Scanner during the Fiscal of 2015-2016. The object was scanned at least 
twice to capture both 360 degrees information along the x and y axis.  
  
The raw and textured files are minimally processed. They have been trimmed of the scanning stand upon which the object 
sat, the two or more scans aligned, the  
 
alignment refined, and then fused together. They were then exported into .STL (raw) and .OBJ (textured) files types.  
 
The print file was decimated (reduced in size), edited for holes and orientation in Meshlab (http://meshlab.sourceforge.net/) 
and Meshmixer (http://www.meshmixer.com/)  
 
softwares. The file was then uploaded into the Microsoft and Netfabb 3D printing Model repair software here: 
https://modelrepair.azurewebsites.net/ 
 
The Files: 
----------  
 
1. designer_cube-raw.stl : 384  MB   
2. designer_cube-print.stl : 45.8 MB 
3. designer_cube-textured.zip    : 661  MB   
4. README.txt   : 1.22 KB 


